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Before you can use Basic PAYE Tools you must first add an employer. To add an employer, please
~ follow the link below.

Menu Add an employer »

b &dd an employer . o .
If you have used Basic PAYE Tools 2012, you can transfer your existing data by following the

relevant link in the 'Menu’ on the left.

If you have already set up an employer, please follow the relevant link in the 'Employer’ list on the
left,

Motifications will appear below throughout the tax year to help you deal with yvour payraoll,

b Back up your data
b Restore your data
¥ Transfer data from Basic PAYE Tools 2012

Once you have added an employer, you can also back up or restore your data by selecting the
relevant link in the left hand menu.

Navigation

vou can find further details and guidance in the 'Useful information' section below.

Employers
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Overview and Disclaimer (please read before downloading the Tools)

This guide is provided as an overview to the most common network installation requirements of
Basic PAYE Tools — Real Time Information. Please note that this guide is advisory, and may differ in
regards to your specific environment, product version or system configuration.

This guide is provided for guidance only. HMRC will not be responsible for any loss, damage, cost or
expense arising out of the installation and use of this application or the advice given in this
document. The security of the data held in the Basic PAYE Tools is your responsibility.

The Basic PAYE Tools is not designed to be installed on an IT network, and there are risks in doing
this which you must recognise and accept before you take such a course of action.

This guide is designed to be read by people who understand IT networks, and have experience of
configuring files, folders and settings on IT networks.

Due to the complexities of IT networks, HMRC is unable to provide any further advice on installing
Basic PAYE Tools for Real Time Information onto a networked computer beyond that set out in this
guide.

HMRC strongly recommends that you backup your data before following any instructions in this
guide.



Guides

I want to install Basic PAYE Tools - Real Time Information on one computer and store the

database on a network drive or network computer

Installation

e Install Basic PAYE Tools — Real Time Information on the computer you want to use the

software upon, accepting the default options.

e Open the application at least once to setup the database and confirm installation success.

Amend the database location
e Open My Computer (Windows Explorer) on your computer:

-

~ 4 Hard Disk Drives (2)
- 0SDisk (C:)

b 57.2 GB free of 111 GB

m

=ER)
':\___)"\___)' L-;‘ b @ o - |¢,| | Search Computer 3
Organize v System properties Uninstall or change a program Map netwark drive Open Control Panel j:: - [ @

Data (D)

~ o -
S 109 GB free of 465 GB




o Type %appdata% in the address bar and press Enter on your keyboard.

':\___)"\___)' L.; %appdata’ v| = | | Search Computer P

Organize v System propel

or change a program

1M %appdata®

QU

Organize v

Systemn properties Uninstall or change

L ]

e Navigate to the HMRC folder by double clicking on the folder:

=)

@u'| b « - . - |¢,| | Search Roaming Pl
Organize » Include in library = Share with » Burn New folder 4= ~ [0 @
Narme ’ Date modified Type Size
- | Adobe 19/11/2012 08:29 File folder
j ATI 01/10/2012 14:46 File folder =
= .. Dropbox 14/1272012 07:41 File folder
.. FileZilla 13/12/2012 16:01 File folder 4
.. full phat 20/11/72012 13:49 File folder
. GitHub 09/10/2012 13:56 File folder
m . HMRC 11/12/2012 11:48 File folder
W Identitie]} 02/10/2012 10:32 File folder
. Install5hield 02/10/2012 12:04 File folder
.. Intel Corporation 02/10/2012 12:06 File folder
. JetBrains 111272012 10:55 File folder
| annehar NRANN 1720 File fnlder k¥4
LN 1 +
l 29 items
g oy




Right click on the payetools-rti folder:

g

m

-

Open in new window

7-Zip ’

Scan with Microsoft Security Essentials...
Cut |}

Copy

Create shertcut

Delete

Rename

Properties

@.\‘;}'| S v|¢7|| Learch HMRC pl
Organize » Include in library « Share with » New folder == m @
Mame Date medified Type Size
- | payetools-rti 18/03/2013 07:50 File folder
x4 1n P
i 1 item
.
Select Cut in the menu that appears:

[ (=] o )
@uv| < . - ~ [ 45| [ search HMRC Pl
Organize = = Open Include in library « Share with « Burn Mew folder H== il @

i Mame Date modified Type Size
- . payetools-rti A IAS AN A ATLEn Eile folder
Open

< |

1L}

payetools-rti Date modified: 18/03,/2013 07:50

i File folder

-

Navigate to the network location that you want to use the database from. The example

given here is a network location named \\NETWORK-DRIVE\

Please replace the network drive location in the following instructions with the address of
the location you want to store the data. Right click in the location you want to store the




database on the network:

fa - EI Eg il
@Uv[ . \\NETWORK-DRIVE\ ~ | = || Seorch New foider P
QOrganize = New folder = 0l @

l;l Name Date modified Type Size
e This folder is empty.
E| q I b
0 items Offline status: Online
l Offline availability: Mot awailable

L

Select Paste from the menu provided:

e

&) =[ 1 vnETwork-DRIVEY

vJ - | | Search New folder

Organize +

Mew folder

0 itemns

I

MName

£ [ F—

Offline status: Online

Date modified

This folder is empty.

View »
Sort by »
Group by »

Refresh
Customize this folder...

Paste k
Paste sh ut

Unde Delete Ctri+Z

Mew 3

Properties

Type

Size

Offline availability: Mot awailable

L

This will remove the database from your local computer and place it into the network

location.



Software Configuration
e Now you must inform Basic PAYE Tools — Real Time Information where you have moved the
database to. Select the start button:

A

ToMo

Documents
Pictures

Music

Computer

Control Panel
Devices and Printers
Default Programs

Help and Support

> AllPrograms

| |Search pragrams and files

Programs (2)

| | Notepad

- e

Files (2)

p See more results

| notepad| ‘ Shut down | 3 |




Right click on the Notepad program located:

Programs (2)
| | Notepad

Files (2)

p See more results

notepad| Shut down | » [
=

Select the Run as administrator option from the menu displayed. If you do not have this
option available, please select the Open option from the menu instead.

Programs (2)

Notepad '
(@Notenad [
i —— Open file location
Files (2)
@ Run as administrator -~
- N
J— Share with »

Restore previous versions
Send to 3

Cut
Copy

Delete

Properties

p See more results

| notepad|




You may be prompted with a dialog asking you confirm that you accept the program can

make changes to the computer. Please accept the dialog by clicking on Yes.

Do you want to allow the following program to make

changes to this computer?

)

Program name:
Verified publisher:
Program location:

Motepad
Microsoft Windows

Show information about this publisher's certificate

IIﬁs@[ No__|

Change when these notifications appear

Notepad will now be open. Please navigate to the File menu and select Open:

[ 7] Untitled - Notepad

= i[=

Edit Format View Help

New

Open... N
Save k
Save As...

Page Setup...
Print...

Exit

Ctrl+M
Ctrl+O
Ctrl+5

Ctrl+P

4

=

You will now locate the configuration file for Basic PAYE Tools — Real Time Information.

Please navigate to your C: drive. You may do so by selecting the following option in the left

hand menu. Please note: Your C: drive may not appear like shown. Alternatively you may

type C: into the address bar and press Enter.




::] Open M
o =
UI\‘J |!_-J. v Libraries » Documeznts » - | 3 | Search Documen's ol
Organize * New folder Hes o (7]
Documents library Arrznge by:  Folder
Ircludes: 2 lecations
Name Date modified Type Size
240172013 09535 Filefolder
- 23/10/2012 1250 Filefolder
10/10/2012 1240 Filefolder
- T 26/11/2012 1525 Tilefolder
Ll Computer
&, osDisk tc;‘%}
i
-
File name: - [Text Cocuments (*.td) v]
Encoding: |ANSI v] [ Cpen ] I Cancel l

LS

If you can now see a folder named “Program Files (x86)” please double click to open the

folder. If you can only see a folder named “Program Files”, please double click to open that
folder instead. This demonstration will continue with “Program Files (x86)” as the example:

o ™
| Dpen g
@.’\_'jvm » Computer » OSDisk (C) » +[ %2 Search OsDisk (C; 2|
Organize » Mew folder =« [ @
Mame Ltate modified lype Size
- § ADL 05/03/2013 0946 lilefolder
L AMD 01/10/2012 1443 Filefolder
o Intd 02/10/2012 1205 Filefolder
- MSOCache 09,/10,/2012 0949 Filefolder
J PerfLogs 14/07/2009 04:20 Filefolder
.. Program Files 28/02/2013 1813 Filefolder
| Program Files (x#6) 11/03,/2013 0745 File flder
25/02/2013 0930 Filefolder
= 12/03/2013 0823 Filefolder
03/01/2013 0810 Filefolder
03/01/2013 0810 Filefolder
23/10/2012 17:00 Filefolder
15/10/2012 0803 Filefolder
05/03/2013 09:46 Filefolder
File narne: - IText Cocuments (*.txt) v‘
Encoding: |ANSI v] [ Open ] [ Cancel l
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Navigate to the HMRC folder by double clicking:

j Jpen

@Q-| | » Camputer » OSDisk(C:) » Program Files (6) *

Organize » Mew folder
Mame . Ltate modified lype Size =
- . Adcbe 01/01/2013 1526 lilefolder
L AMD APP 21/01/201313.04 Filefolder E
L AMD AVT 21/01/201312.04 Filefolder
- .. ATlTechnologies 01/10,/2012 14:44 Filefolder
| Balsamig Mockups 03/01/2013 1526 Filefolder
. Bonjour 12/11/2012 1057 Filefolder
- - . Common Files 75/02,/2013 0930 File folder
- » | Evemnote 22/10/2012 0923 File folder
= | Futuremark 01/10/2012 1447 Filefolder
. .. Gocgle 11/03/2013 0745 Filefolder
s HMRC -~ 18/03/2013 0841 Filefolder
m 23/01/2013 1135 Filefolder
01/10/2012 1447 Filefolder
01/10/2012 1258 Filefolder
02/10/2012 11.04 Tilefolder
o 250272013 0930 Filefnlder =
File name: - IText Cocuments (*.td) v‘
Encoding: |ANSI v] [ COpen 1 [ Cancel l
hs 4
Navigate to the payetools-rti folder by double clicking:
- ™
j Jpen u
@vq [ » Computer » OSDisk(C) » ProgramFiles (86) + HMRC » =] %3] Search HMAC 2|
Organize = MNew folder =~ 0 @
Mame ° ™ Uate modried lype Size
- . payztools-rti 18/03/2013 0&.41 Tilefolder
File name: - IText Cocuments (*.td) v‘
Encoding: |ANSI v] | COpen i [ Cancel l
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e You will now be in the correct location; but you cannot currently see all the files available.

Please click the combo box in the bottom right of the dialog, as shown:

ﬁ Open ﬁ
@uv| .. ¢ Computer ¢ OSDice (C:) » Prcgram Files (386) » HMEC » payetools-rti » - | £y | | Search payetools-rit Pel |
Organize + Mew folder -~ Bl @

> Mame * Date modified Type Size
- | debug_toclbar 18/03/2013 08:£1 File folder
| imageformats 18/03/2013 08:41 File folder
 legacy 18/03/2013 08:41 File folder
A 1 python 18/03/2013 0&:£1 File folder
| static 18/03/2013 D8:£1 File folder
. templates 18/03/2013 08:41 File folder
| license.bet 2/03/2013 09:39 Text Docurment 1KB
| readme. b 12/03/2013 09:39 Text Document 6 KB
File name: - lext Documents (™&xt) \ -
Encucing: | ARSI '] [ COpen 1 ’ Ca:::_:l l

e Select the All Files (*.*) option by clicking it:

-
|| Open M
@L}'| . » Computer » OS5Disk (C:) » Program Files (86) » HMRC » payetools-rti » - | by | | Search payeto go |
Organize » New folcer = I @
MName Date modified Type Size
- . debug_toolbar 18/03/2013 08:£1 File folder
| imageformats 18/03/2013 08:41 File folder
. legacy 18/03/2013 08:41 File folder
L . python 18/03/2013 08:41 File folder
| static 18/03/2013 08:£1 File folder
- 4 | templates 18/03/2013 08:21 File folder
5 =l licersetxt 12/03/2013 09:39 Text Document 1KB
| readme.tt 12/03/2013 03:33 Text Document 6 KD
]
File name: YJ

X Text Documents (")

b ‘T. Documents (Tt}

12




You will now be able to see all the files. Click on the rti.cfg file in this folder. Please note, this
file may just be called rti on your computer:

-
E Upen u
@f\_)v| . v Computzr » 35Disk (C) » Program Files (6) » HMRC » payetodls-rti » - | 44 | Search payetools-rii » |
Urganize * Mew folder = [ @
= Mame Date mocified Type Size
. - .. debug toolbar 18/03/2013 08:41 File folder
.. imageforrrats 18/03/2013 08:4L File folder
L legacy 18/03/2013 D8:4L File fclder
L .. python 18/03/2013 0&:4L File fclder
| static 18/03/2013 0&:41 File folder
— | templates 18,03/2013 03:4L Tile felder
v - | license.bdt 12/03/2013 09:39 Text Document 1KB
- - %) python27.dIl 12/03/2013 09:33 Application extens... 2,250 KB
- - . readmetd 12/03/73 09:39 Tewt Nacument KR
g | L ricfy  n 18/03/2013 0&:41 CFG File LKB
D rtiee by 12/03/2013 09:33 Application 130 KB
@ rti-dagnostics.exs 12/03/2013 09:33 Application 131 KB
|| uninstall.dat 18/03/2013 0&:41 DAT File 27 KB
B Lninslall.ese 18/03/2013 08:4L Applicalion 3,762 KB
. @ update.exe 12/03/2013 09:39 Application 6,861 KB
- i E
File rame: rti.cfc + [anFies ¢ -
Encoding: | AMSI '] [ Open | ’ Cancel ]

LS

Click the Open button to open the file:

13

| Open M
@uv| . » Computer » OSDisc(C:) » Prcgram Files (386) » HMRC » payetools-rti » - | by | | Search payetools-rti pel |
Organize * New folder =~ 0 @

Name Date modified Type Size
. - | debug_toclbar 18/03/2013 08:£1 File folder
. imageformats 18/04/2013 U¥:41 Hile tolder
1 legacy 18/03/2013 08:£1 File folder
| 2 I pytkon 18/03/2013 0&:£1 File folder
L slatic 18/03/2013 08:41 File fulder
_— | temolates 18/03/2013 D8:£1 File folder
v - | | license.bet 12/03/2013 09:39 Text Document 1KB
- b %] python27.dIl 13/p3/2013 09:28 Application extenc... 2,250 KB
- —  _ readmetx 12/03/2013 09:39 Text Document 6 KB
- | ] rticfg 18/03/2013 08:£1 CFGFile 1KB
@ rtieze 12/03/2013 09:38 Application 130 KB
@ rti-diagnostics.exe 12/03/2013 09:38 Application 131 KB
|| umirstall.dat 18/05/2013 Us:dl DAT Hle 21 KB
& ynirstall.ece 18/03/2013 08:£1 Application 3,762 KB
. # update.exe 12/03/2013 09:39 Application 6,851 KB
File name: rti.cfg - [anFiles ¢ -
Encocing: | ANSI '] [ Open "ﬁ I Cancel l




The file will now open in Notepad. Please note the lines in the file that you will amend:

7 rti.cfg - Notepad =8

File Edit Format View Help

[General] -
userdatamode=0

userdatadir=C:"Users’ ToMo“AppData' Roaming HMRC  payetools-rti

Tistenport=46729

assistive=0

[update]
ur lroot= d
check_for_updates=1

[Components]
Core=13.0.13071.41

Please amend the lines shown below to read:

userdatamode=2
userdatadir=\\NETWORK-DRIVE\payetools-rti

Please remember to amend the location of \\NETWORK-DRIVE\ to suit your environment.
==

| rticfg - Notepad
File Edit Format Wiew Help

[General] P
userdatamode=2
userdatadir="\NETWORK-DRIVE"payetools-rti

o/ LY

assistive=0

[U?date]
ur lroot=
check_for_updates=1

[Components]
Core=13.0.13071.41

.

Select the File menu and select Save:

j rti.cfg - Notepad = | =l

Edit Format View Help

Mew Ctrl+ M &
Open... Ctrl+O [ IVE‘\payetools-rti

Save Ctrl+5

Save Ags...

Page Setup...

Print... Ctrl+P

Exit

14



e Finally, select the File menu and select Exit:

" rticfg - Notepad

(=B [l

Mew Ctrl+M

Open... Ctrl+O  [IVE‘\payetools-rti
Save Ctrl+5

Save As..

Page Setup...

Print... Crl+P

Exit

Open Basic PAYE Tools — Real Time Information and confirm the installation success by viewing
existing employers and/or adding new employers or employees.

You have now completed the installation.

15



I want to install Basic PAYE Tools - Real Time Information on multiple computers and
store the database on a network drive or network computer which all computers will
access

Note: Basic PAYE Tools — Real Time Information is not designed to support multiple computers
accessing the same database. If two separate computers use the database at the same time,

database corruption will occur. If this is your selected installation method, please ensure that only

one computer uses the software at any time.

Installation
e Install Basic PAYE Tools — Real Time Information on each computer you want to use the
software upon, accepting the default options.
e Open the software application on one computer to setup the database.

Amend the database location
On the computer that you opened the software application to create the database, follow the
instructions given for amending the database location in the “I want to install Basic PAYE Tools —

Real Time Information on one computer and store the database on a network drive or network
computer” section, here.

Software Configuration
On each computer that you want to connect to the database, follow the instructions given for
Software Configuration in “I want to install Basic PAYE Tools — Real Time Information on one

computer and store the database on a network drive or network computer” section, here.

Open Basic PAYE Tools — Real Time Information on one computer and make an amendment to the
Employer. Close the software and then open Basic PAYE Tools — Real Time Information on another
computer to confirm the shared database.

You have now completed the installation.

16



I want to install Basic PAYE Tools - Real Time Information on one networked computer
or drive and run it from multiple computers, each with their own database.

Installation

e Install Basic PAYE Tools — Real Time Information on the computer or drive you want the
software to reside.

You may want to select a custom installation to select the destination folder for the Basic
PAYE Tools — Real Time Information software product.

e Download and install the Microsoft Visual C++ 2008 Redistributable on each computer that
you want to run Basic PAYE Tools — Real Time Information upon, or check that it is currently
installed.

It is available from: http://www.microsoft.com/en-us/download/details.aspx?id=5582

If everything went well, opening Basic PAYE Tools — Real Time Information from each computer from
the shared location will work as expected. You can confirm this by viewing existing employers and/or
adding new employers or employees to the product.

Open Basic PAYE Tools — Real Time Information on more than one computer and confirm that the
database is not shared.

You have now completed the installation.

17
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I want to install Basic PAYE Tools - Real Time Information on one networked computer
or drive and run it from multiple computers, and store the database on a network drive
or network computer which all computers will share

Note: Basic PAYE Tools — Real Time Information is not designed to support multiple computers
accessing the same database. If two separate computers use the database at the same time,
database corruption will occur. If this is your selected installation method, please ensure that only
one computer uses the software at any time.

Installation

e Install Basic PAYE Tools — Real Time Information on the computer or drive you want the
software to reside.

You may want to select a custom installation to select the destination folder for the Basic
PAYE Tools — Real Time Information software product.

e Download and install the Microsoft Visual C++ 2008 Redistributable on each computer that
you want to run Basic PAYE Tools — Real Time Information upon, or check that it is currently
installed.

It is available from: http://www.microsoft.com/en-us/download/details.aspx?id=5582

e Open the software application from the shared location on one computer to setup the
database.

Amend the database location
On the computer that you opened the software application to create the database, follow the
instructions given for amending the database location in the “I want to install Basic PAYE Tools —

Real Time Information on one computer and store the database on a network drive or network
computer” section, here.

Software Configuration
On the network computer or network drive that you installed the shared software product upon,
follow the instructions given for Software Configuration in “l want to install Basic PAYE Tools — Real

Time Information on one computer and store the database on a network drive or network

computer” section, here.

Note that the location of the software may differ, dependant on where you selected to install the
software product initially.

If everything went well, opening Basic PAYE Tools — Real Time Information from the shared location
on a computer will work as expected. You can confirm this by viewing existing employers and/or
adding new employers or employees.

Open Basic PAYE Tools — Real Time Information on one computer and make an amendment to the
Employer. Close the software and then open Basic PAYE Tools — Real Time Information on another
computer to confirm the shared database.

You have now completed the installation.
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